MOE – Molecular mechanics and force fields

This computer lab is aimed to get you familiar with the MOE program and the features included in it.

The tutorial includes the following exercises:

- Building a Small Molecule
- Saving and Loading a Molecule File
- Saving a Molecule in a Database
- Rendering the Molecule
- Selecting Atoms
  - Repositioning Selected Atoms
  - Rotating About a Bond
- Introducing the Atom Manager
- Measuring Angles and Distances
- Measuring Energy
- Running a Conformation Search
  - Database Creation
  - Plotting Using the Database Viewer
  - Loading Molecules from the Database to MOE and Back
- Running and Animating a Molecular Dynamics Simulation
- Building a Protein
- Introducing the Sequence Editor
  - Selecting Atoms and Residues

Conventions Used in this Tutorial

<table>
<thead>
<tr>
<th>MOE</th>
<th>MOE Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>SE</td>
<td>Sequence Editor</td>
</tr>
<tr>
<td>DBV</td>
<td>Database Viewer</td>
</tr>
<tr>
<td>CLI</td>
<td>Command Line Interface</td>
</tr>
<tr>
<td>MOE</td>
<td>RHS</td>
</tr>
<tr>
<td>MOE</td>
<td>Footer</td>
</tr>
</tbody>
</table>
Building a Small Molecule

When first started, MOE always displays its main window, the **MOE Window**, in which molecular systems are rendered and manipulated.

Small molecules can be built using the Molecule Builder. In this exercise, we will build a molecule of aspirin, as pictured below:

1. Open the Molecule Builder: **MOE | Edit | Build | Molecule**

2. Create an aromatic ring by pressing the benzene button, located in the top right corner of the Molecule Builder.
3. Press the View button to center the molecular system in the MOE Window: **MOE | RHS | View**

4. Render the molecule as cylinders by selecting choosing the appropriate button in: **MOE | Render | Atoms.**

5. Choose **MOE | Render | Atoms | Label | Element** to label all atoms by element.

6. To add a carboxyl group, select one of the benzene hydrogens by clicking the left mouse button on it. Substitute it with a carboxyl group by clicking on **-COOH** in the Builder.

7. To add a hydroxyl group, select a hydrogen atom *ortho* to the carboxyl group. In the Builder, click on **O** in the Element buttons.

8. To acetylate the hydroxyl group, select the hydroxyl hydrogen in the MOE Window and click on the **-C=O** substituent button in the Builder, followed by the **C** element button. You have now completed the aspirin molecule.

We could also have built the aspirin molecule by typing:

\[ \text{O(C(=O)C)c1c(C(=O)O)cccc1} \]

in the SMILES String text field of the Molecule Builder and then pressing the SMILES button.
9. Press the View button to center the molecular system in the MOE Window: MOE | RHS | View

10. Rotate the molecule by dragging the middle mouse button in the MOE Window. You can also rotate the molecule using the trackball in the RHS.

When rotating the molecule in the window, the center of rotation is the center of mass of the entire molecular system. When zoomed in close to an atom, however, you may prefer to localize movement by forcing rotation about the atom. To do so, click the middle button on the atom, then rotate the molecule by dragging the middle mouse button. To regain the default setting, simply click the middle button in the MOE Window away from any atoms.

11. To pan the molecule, press Shift and drag the middle mouse button. To pan the molecule with the trackball (MOE | RHS | Trackball), activate panning mode by clicking in the gray square at the bottom left of the trackball (the square is labeled "R" when in rotation mode and "T" when in translation mode).
12. To zoom in or out, press Ctrl and drag the middle mouse button. Alternatively, if your mouse is equipped with a scroll wheel, it can also be used to control zooming. Another alternative is using the wheel below the trackball.

13. To apply the MMFF94x forcefield, choose:

   **MOE | Window | Potential Setup**

   In the Potential Setup panel, choose the MMFF94x forcefield by selecting it in the Load... pulldown menu. Close the panel.

14. Compute partial charges by choosing:

   **MOE | Compute | Partial Charges**

   ![Partial Charges dialog box](image)

   Leave the Method as **Current Forcefield** and press OK. This uses the default charge calculation associated with the current forcefield.

15. Minimize the energy of the molecular system by choosing the Minimize button in the Right Button Bar of the MOE Window.

**Questions**

1. Which force fields are available in MOE?

2. Why are we using MMFF94x in this tutorial with aspirin?
Saving and Loading a Molecule File

1. Save the acetylsalicylic acid molecule you have just built:

   **MOE | File | Save...**

   Double-click on the directory in which to save the molecule file. Next, enter *aspirin* in the text field and save with a .moe extension (the MOE file extension). Press Save.

   **Tip** For quick access to MOE directories, click on the arrow in the text field. This opens the shortcut list of recent directory paths.

2. Now, you will load the newly saved molecule back into MOE. However, before doing so, you must first clear the data currently in MOE:

   **MOE | File | Close**

3. Load the molecule back into MOE:

   **MOE | File | Open**

   In the Open panel, select *aspirin.moe* from the list of files and press OK.

   If, after loading the molecule file, nothing appears in the MOE window, it may be that the molecule is not visible with the current viewing parameters. To change the view so that the molecule is fully visible, choose **MOE | Render | View**.

Saving a Molecule in a Database

When building complex molecules in MOE, it is convenient to save and retrieve molecular fragments to and from a database. Below is a short example on how to create a database and copy the aspirin molecule from MOE to the database.

1. To create a molecular database, choose:

   **MOE | File | New | Database**

   a. In the New Database panel, select the directory in which the new database will be saved.
   b. In the Path text field, enter *aspirin.mdb*.
   c. Press OK. The new database appears in a MOE Database Viewer. The database contains a single field called *mol*, which is of type *molecule*.
2. Create a second field in the database, which will contain the molecule names, by selecting:

   DBV | Edit | New | Field...

   The command line in the Database Viewer changes to a prompt. Choose char in the Type option menu to create a textual field. Next, enter Molecule Name in the Name text box and press Return. A new field called Molecule Name is created in the database.

3. To copy the aspirin molecule from the current system to the database, choose:

   DBV | Edit | New | Entry...

   In the Add Entry panel, select Mode: System and type aspirin in the Molecule Name text field. Press OK. Both fields now contain information in the database.

4. In the Database Viewer, to get a better view of the molecule in the database, position the cursor over the cell in the first column (called mol), press the left mouse button and drag down (and slightly to the right) until you clearly see the molecular drawing. You can rotate the drawing by dragging the middle mouse button over it.

5. Only the heavy atoms are displayed in the Database Viewer. To display hydrogen atoms, choose:

   DBV | Display | Molecule | Hydrogens

**Rendering the Molecule**

The Render menu allows you to change the visual display mode of the current molecule. The primary rendering controls are found in MOE | Render | Atoms, which can also be opened using MOE | Footer | Atoms.

The default rendering mode is Line mode, which is also the fastest drawing mode. In building the aspirin molecule, you previously used the Render menu to change to Stick
mode. Three other modes are: Ball and Line, Ball and Stick, and Space Filling. There is even a None (no bonds) mode. Take a moment now to try each rendering mode.

Note that if you have any selected atoms, the chosen rendering will affect only those atoms. The following steps will show you how to render different parts of a system in distinct modes:

1. To set the entire molecule in Stick mode, use MOE | Render | Atoms. (Make sure no atoms are selected).

2. To select all the benzene carbons, open the Atom Selector with MOE | Selection | Atom Selector. In the SMILES text field, type a to indicate aromatic atoms and press All. This will perform a substructure search and select all atoms within the matching strings.

3. Choose the appropriate button in MOE | Render | Atoms to display the atom nuclei of only the ring carbons as small spheres.

The rendering options allow atoms to be labeled and colored according to charge and element type. You may wish to take a moment now to experiment with the various Label and Color buttons in the MOE | Render | Atoms panel.

Individually selected atoms, hydrogens, residues and sidechains may be shown or hidden using the MOE | Render | Hide and MOE | Render | Show submenus. The Backbone, Sidechain and All options are useful when studying proteins and polymers. You will have an opportunity to experiment with these commands later when we create a protein. For now, hide the hydrogens on the aspirin molecule with MOE | Render | Hide | Hydrogens. To make the atoms visible again, use MOE | Render | Show | All.

The Render menu is also used for setting the viewpoint from which the molecule is observed. MOE | Render | View is equivalent to MOE | RHS | View. These operate on selected atoms or on all atoms if none are selected, and adjust the view so that all atoms in question can be seen and are centered in the Main Window. The View can also be set using the MOE | Footer | Trackball Popup | View menu.

To demonstrate the use of MOE | Render | View on selected atoms, we begin by selecting a few atoms in the aspirin molecule:

1. Select all oxygen atoms with MOE | Selection | Atom Selector. Open the Periodic Table and choose O.

2. Select MOE | Render | View. In the MOE window, the view is now zoomed in on the part of the molecule containing the selected atoms.
Selecting Atoms

To change the properties of a molecule or manipulate a subset of its atoms, you must first indicate which atoms are to be manipulated by creating an atom selection set. Selected atoms are identified by a change in color and a (small) sphere depending on the current rendering mode of the atom selected.

Use the mouse to manually select atoms:

1. Make a selection set consisting of a single atom by clicking the left mouse button on any atom. This will cause all other selected atoms to become unselected.

2. Select all atoms of a residue by pressing Ctrl while clicking the left mouse button on an atom. In the case of the aspirin molecule, all atoms belong to the same residue, hence, all atoms are selected. Hidden atoms are also selected.

3. Add a single atom to the selection set by pressing Shift while clicking the left mouse button on an atom. This toggles the atom selection state. You can add all atoms of a residue to the selection set by holding down both Shift and Ctrl when clicking the left mouse button. You cannot, however, click on hidden atoms.

4. Draw a selection box around a group of atoms by dragging the left mouse button over the atoms you want to select. A selection box is drawn as you drag the mouse. When you release the left mouse button, all atoms within the box become selected. To add more atoms to the selection set, drag a new box while pressing Shift.

The Selection menu allows you to add atoms to the atom selection set according to element type and geometry (hybridization). In addition, atoms can be selected based on whether they belong to the molecule backbone or to a side chain and whether they have been hidden (e.g. using MOE | Render | Hide) or fixed (e.g. using MOE | Edit | Potential | Fix). The MOE | Selection | Extend submenu allows you to extend the atom selection set from the currently selected atoms.

To remove atoms from the atom selection set, press Shift and click on the atoms you wish to deselect.

Repositioning Selected Atoms

Selected atoms can be moved independently of the rest of the molecule by dragging the middle mouse button in combination with the Shift key while holding down the Alt key. Pressing the Alt key specifies that only selected atoms are to be moved.

To rotate selected atoms in space, press the Alt key and drag the middle mouse button. To translate selected atoms, press Shift in addition to the Alt key. The RHS | Trackball
can also be used to manipulate the selected atoms, again by pressing Alt while using the trackball.

Rotating About a Bond

1. Clear the selection set by clicking in the MOE Window away from any atoms.

2. Select a single atom with the left mouse button.

3. Select a second atom that is bonded to the first by holding down Shift and clicking the left mouse button on the atom. To rotate about a bond, exactly two atoms joined by a bond must be selected.

4. Press the Alt key and drag the left mouse button.

When rotation is possible, the smaller group will rotate, while the larger group remains still. If no rotation occurs, it may be because the bond is in a ring, or because there are fixed atoms preventing the rotation. Also, if one of the selected atoms has no other atoms bonded to it, no apparent rotation will result.

Introducing the Atom Manager

The Atom Manager provides detailed information about the individual atoms in a molecular system, such as element name, hybridization and charge, as well as information about other molecular objects.

Molecules have a hierarchical composition. Atoms are the children of residues, and residues are the children of chains. The chain-residue relationship is explicitly mapped out in the Sequence Editor. The Atom Manager can be used to modify atom, residue and chain properties.

1. Double-click on an atom. This opens the Atom Manager which lists all atoms, residues and chains found in the MOE Window, along with their properties. (Another way of opening the Atom Manager is by choosing MOE | Window | Atom Manager.)

2. Select a residue line in the list by clicking the left mouse button on a Residue line. In the edit area at the bottom of the panel, residue properties such as name and type can be edited.

3. Select a Chain line in the list to see the chain properties available for editing.

4. Press the Compress All button. Only the chain listings are displayed.
5. To uncompress a single chain, double-click the left mouse button on it. Similarly, double-click on a residue line to uncompress it.

6. Press **Expand All** to restore the full listing.

7. Click the left mouse button on an atom line. The properties of this atom are now editable.

8. Press **MOE | RHS | Select** (use the blue button not the menu) to open the Atom Selector panel. Select all carbons using the **Table** pulldown menu in the **Element** section. In the Atom Manager, turn on the **Selection Only** checkbox. The list now displays information only for the selected atoms.

Suppose, for instance, that you wish to replace one of the benzene carbons in the aspirin molecule with a nitrogen atom:

1. Choose the carbon to transform by selecting the appropriate line in the Atom Manager.

2. In the **Name** field, type N.

3. Select N from the periodic table that opens when you click on **Element**.

4. Press **Apply** to put the changes into effect.

You can also edit atom properties using the Molecule Builder. Changes are immediately reflected in the MOE Window and in the Atom Manager.

After modifying an element, you may need to correct the partial charges. Use the **MOE | Compute | Partial Charges** panel to do this. Again, information in the Atom Manager is updated immediately.

### Measuring Angles and Distances

Steric measurements are made choosing **MOE | RHS | Measure**. Distances are measured in angstroms, and angles in degrees.

1. Choose **MOE | RHS | Measure**. The CLI in the MOE window becomes a prompt area for measuring distances, angles or dihedrals and the cursor becomes a crosshair. By default, the Measure menu is set to Distance. You are prompted to select the first and second atoms.

2. Select any two atoms. A colored meter appears, with its distance measured in angstroms. (If meters are not being displayed, turn on the **MOE | Render | Draw | Meters** checkbox.)
3. Cancel the meters prompt by pressing the Esc key.

4. Meters are dynamically updated whenever changes occur in a molecule's conformation. You can verify this by selecting one of the atoms implicated in a meter and moving it (hold down Shift and Alt and drag the middle mouse button).

5. To hide the meters, turn off the MOE | Render | Draw | Meters checkbox in the Render menu.

6. Meters can be deleted using the MOE | Edit | Measure | Remove menu.

Measuring Energy

Display the potential energy of the entire system of atoms using MOE | Compute | Potential Energy.

The MOE | Compute | Conformations | Dihedral Energy Plot command also calculates the potential energy of the entire molecular system. It makes a succession of calculations as the atoms attached to one side of the user-specified rotatable bond are rotated through 360 degrees. The differences in potential energies are then plotted against the dihedral angle, with the current angle and energy indicated by a vertical line.

1. Choose MOE | Compute | Conformations | Dihedral Energy Plot. A prompt appears in the CLI.

2. Select four atoms specifying the bond about which the dihedral energy at different angles of rotation is to be calculated. Rotation may be impossible if the selected atoms belong to a ring system, or if there are fixed atoms.

3. A dihedral energy vs. angle plot appears.

4. To cancel the atom-prompting operation, press the Esc key.

The MOE | Compute | Conformations | Dihedral Contour Plot command performs a similar calculation except that the potential energy is calculated as a function of two dihedral angles, thus yielding an energy surface. The surface is plotted in 2D as a contour plot. To stop the energy calculation once rotations have begun, use the Cancel menu in the upper right corner of the window.

The MOE | GizMOE | Energy command runs a potential energy calculation job in the background. This continuously calculates the energy, which it displays in the MOE Window. Select and move an atom (Shift-Alt - drag the middle mouse button) in the MOE Window. The printed energy values update dynamically.
Running a Conformation Search

MOE has several conformational search modules. We will use the Systematic Conformational Search to search for the minimum energy conformations of the aspirin molecule. The search is conducted by calculating the energy of the molecule for the different angles of all its rotatable bonds. At each step, the dihedral bond angles are varied systematically, and the molecule is minimized. The energies of the different conformations are monitored, and the product of the search is a series of conformations with energies below a user-specifiable cutoff.

1. Start the conformation search by choosing:

   **MOE | Compute | Conformations | Conformational Search**

   This opens the Conformational Search panel. For the purposes of this tutorial, you will use most of the default values. Select the **Method: Systematic** option. Make sure that the Open Database Viewer option is selected as this will automatically open the database (by default, `csearch.mdb`) in which the resulting molecule conformations will be stored.

2. Press OK to start the search. During the search, you can observe the database file being written in real-time.

Database Creation

In the first step of the conformation search, the database is filled with the conformations of the aspirin molecule -- all generated by bond rotations -- whose energies fall within 7 kcal (by default) of the minimum energy conformation found. Finally, duplicate conformations are eliminated.

To tell when the search has terminated, click on the **Cancel** menu in the upper right-hand corner of the MOE Window. If Conformational Search no longer appears, this means that the search is over. In any event, you can terminate the searching operation at any time by choosing Conformational Search in the Cancel menu.

In the database created by the conformation search, molecules are saved in the field labeled `mol`. The `mol` field contains line drawings of the conformations of the aspirin molecule. When it first appears, it is compressed to its minimum size.

- To enlarge the `mol` field, click the left mouse button anywhere in the `mol` column (except on the topmost box containing the field name) and drag the mouse sideways and down. All the cells will resize. Enlarging the cells sufficiently allows element labels and bond orders to be displayed.
- Rotate a molecule line drawing by dragging the middle mouse button within a molecule cell.
- Zoom into a molecule by dragging the middle mouse button while pressing Ctrl.
The Display menu in the Database Viewer menu bar contains various commands that control molecular drawing. For example, you can draw hydrogens and element symbols for each molecular entry.

**Plotting Using the Database Viewer**

The Database Viewer includes an area for plotting numerical data.

1. Open the plot area by turning on the **DBV | Display | Plot** toggle button.

2. Plot the energies of all the molecules by selecting the energy (E) toggle from the **Plot Fields** menu. Once selected, the color of the toggle box will be the same as the corresponding line in the plot.

3. Resize the plot to suit the range of data values by choosing **Zoom | Fit** in the Plot popup. The popup menu is opened by clicking the **mouse popup button** in the plot area.

4. The plot area has a ticked vertical axis. Position your mouse cursor on or near a data point in the plot, and hold it motionless for one second. A yellow bubble will display the database entry number corresponding to the plot point.

5. The selection of entries in the database corresponds to selected points in the plot area. Select some entries in the database by clicking the left mouse button on the entry numbers. Notice that the corresponding data points are circled in the plot area. Try the following selection techniques:
   a. Select a range of entries: click the left mouse button on the first entry, then hold **Shift** and click the left mouse button on the last entry of the range.
   b. Add another entry to the selected entries: press **Ctrl** while clicking the left mouse button.
   c. Add a second range of entries to the first: press **Shift** and click the left mouse button on the end of the range.

6. Entries can also be selected by selecting data points in the plot area. Try the following:
   a. Select individual plot points by clicking the left mouse button in the plot area near data points.
   b. Select a group of points by dragging the left mouse button. All points in the rectangular area that is swept out will be selected.
   c. Select a group of points whose values fall within a given range by clicking the left mouse button in the vertical ruler and dragging the mouse up or down. All points in the delineated range are specified.

7. To clear the selection, choose **Select | Clear** from the Plot popup menu.
Loading Molecules from the Database to MOE and Back

The molecules in a Database Viewer molecule field can be loaded into MOE by double-clicking the left mouse button within one of the cells. The Copy Database Molecule to MOE panel appears. You will be queried whether you wish to delete the data in the current system or to add to it.

You can load several database molecules into MOE at the same time by first selecting the desired entries and then using the Molecule popup menu. Position the cursor over one of the molecule cells and click the mouse popup button. Choosing Selected to MOE will copy all the molecules of the selected entries.

Conversely, molecules can be copied from MOE and stored into an existing molecule cell. Click the right mouse button in a database molecule cell to open the Molecule popup menu and choose Get from MOE. (Remember that to create a new entry you use DBV | Edit | New | Entry.)

Running and Animating a Molecular Dynamics Simulation

A molecular dynamics simulation models a molecule's motion under particular conditions of heat and pressure that may change at various stages of the simulation. Molecular dynamics simulations are used for such purposes as conformation search, and for calculating thermodynamic properties.

1. Reload the aspirin molecule into the current system:

   MOE | File | Open

   In the Open panel, select $MOE/sample/mol/asa.mol. If the MOE Window contains any molecular data, be sure to close the system first.

2. Start the molecular dynamics operation by choosing:

   MOE | Compute | Simulations | Dynamics

   This opens the Dynamics panel. For the purposes of this tutorial, you will modify some of the default values in order to shorten the time to run the simulation:

   a. Select the Open Database Viewer option. This will automatically open the output database (dynamics.mdb) in which the results will be stored.

   b. Change the picosecond Time Step from 0.002 to 0.003

   c. Change the picosecond Save: ... Every: from 0.5 to 1.0
Press **OK** to start the simulation. The simulation will take a few minutes and the output will open in a database viewer.

Once the simulation is complete, you can review the dynamics simulation as a movie animation:

1. Close the current molecular data:

   **MOE | File | Close**

2. Open the Database Browser panel in the Database Viewer:

   **DBV | File | Browse...**

The Database Browser loads the molecular conformations into the MOE Window at a certain animation speed. In other words, it animates the various conformations generated by the molecular dynamics run.

There are several ways of controlling the animation:

a. Move the **Entry** slider by dragging the left mouse button. The slider is used to manually animate the conformations stored in the database.

   The entry number of the molecule currently loaded in MOE appears in the text field beside the slider.

b. You can step forwards or backwards through the animation using the and buttons. The and buttons will respectively jump to the last and first entry of the database.

c. The **Animation** wheel controls the speed of the animation. Moving the wheel to the right accelerates the animation rate. Moving the wheel all the way to the left stops the animation.

   You can run a continuous animation loop by dragging the animation wheel right and selecting the **Loop** option. To stop the looping, click on the grey square to the right of the wheel.

**Question**

Give definitions (in your own words) of energy minimization and molecular dynamics simulation.
Building a Protein

We will show one of the methods for building proteins. As an example, we will build oxytocin, a pituitary hormone that causes uterine contractions during birth. Oxytocin is a cyclic peptide with a disulfide cysteine link.

1. Clear any current molecular data:

   MOE | File | Close

2. Open the Protein Builder:

   MOE | Edit | Build | Protein

3. Using the buttons in the Residue button bank, enter the following sequence of amino acids: CYS, TYR, ILE, GLN, ASN, CYS, PRO, LEU, GLY.

   By default, the polypeptide is built in extended geometry mode in the MOE Window.

4. Press View in the Protein Builder panel to make the entire molecule visible. Close the Protein Builder by pressing Close.

5. The next steps involve identifying and bonding the two CYS sulfur atoms:
   a. Select the two sulfur atoms:

      MOE | Selection | Atom Selector. Choose S from the Periodic Table.

   b. Add labels to the two selected sulfur atoms:

      MOE | Render | Atoms | Label: Element

   c. Bond the selected atoms by pressing the Single Bond button in the Molecule Builder. The bond is drawn between the atoms.

6. Make an amide of the free carboxyl group of GLY. Using the Atom Manager, find the GLY residue and then the carboxyl atom to substitute:
   a. To open the Atom Manager double-click on any atom in the MOE Window. Notice that when the Atom Manager is opened, it highlights the selected atom (which was clicked on) in the list and displays its properties at the bottom of the panel.
   b. Select Compress All to compress the listing.
   c. Expand the chain by double-clicking on it.
   d. Expand the GLY residue, also by double-clicking on it.
   e. In the list, select the GLY OXT atom.
f. In the properties area at the bottom of the panel, turn on the Selected option, then click on Apply. The OXT atom is now selected in the MOE Window.
g. Make sure that no other atoms are selected at this time. To do so, turn on the Selection Only toggle button at the top of the Atom Manager. The list now displays only the selected atoms and their residue and chain lines.
h. Double-click on the oxygen atom that is not the OXT atom to toggle its selection state. It will disappear from the list as it is no longer selected.
i. Open the Molecule Builder:

```plaintext
MOE | Edit | Build | Molecule
```

j. In the Molecule Builder, make the appropriate substitution by clicking on N. Close the Molecule Builder.

7. Compute partial charges:

```plaintext
MOE | Compute | Partial Charges. Press OK.
```

8. Minimize energy:

```plaintext
MOE | Compute | Energy Minimize
```

This opens the Energy Minimization panel. Keep the default values and press OK.

9. You will now set the compound name. Select the chain in the Atom Manager and enter oxytocin in the Name text field. Press Apply then close the Atom Manager.

The Protein Builder can only be used for creating a new protein and appending to that protein. It cannot be used for adding to an already existing protein. Elongating an existing protein is achieved by joining two chains together, for instance, using SE | Edit | Join Chains in the Sequence Editor.

**Introducing the Sequence Editor**

The Sequence Editor is a tool for visualizing molecules in terms of their residues, and acts as a starting point for performing full sequence-to-structure reconstruction. This includes homology analysis as well as secondary structure analysis and prediction on proteins.

1. Clear the current molecular data with MOE | File | Close.

2. We will load a protein from the Protein Database panel (this panel might take a few seconds to load):
3. By default, the list orders proteins alphabetically according to the last three characters of their four-letter PDB codes. Find 2POR PORIN. A quick way of finding proteins is to use the Search field:

Enter 2POR in the Search text field. The list displays 2POR. Select this entry and press Copy to MOE and click OK in the prompt to load it into MOE.

4. To see the beta-barrel, turn on backbone ribbon drawing using the appropriate button in MOE | Render | Ribbon.

5. Open the Sequence Editor with MOE | Window | Sequence Editor.

Tip A shortcut to open the Sequence Editor is to use the keystrokes <Ctrl>-q.

The residues of the currently loaded molecular system are laid out linearly in a schematic diagram in the Sequence Editor. Protein structures may comprise one or more chains which are each composed of a linear succession of residues.

6. The Display menu in the Sequence Editor controls certain visual features:
   o Change from three-letter to single-letter residue display mode with SE | Display | Single Letter Residues.
   o Display secondary structure indicators with SE | Display | Actual Secondary Structure. The colored bars correspond to the backbone ribbon displayed in the MOE Window. Both are calculated dynamically.

7. Some of the colors used in the Sequence Editor can be modified using the Configuration Options panel. Open the panel with SE | Window | Options and switch to the Sequence Editor page to modify the color of the displayed H-Bonds. Choose lightShadow and press Apply to put the change into effect. Close the options panel.

   Note that this change will be saved in your private resource file when you quit MOE. Hence, if you do not like this color, reset the color to one you prefer in the Configuration Options.

8. Change the Sequence Editor residue colors:

   SE | Display | Color Residues

Select Function to color residues according to function. Press Apply to see the changes.
9. Now color the atoms in the MOE Window by residue:

MOE | Render | Atoms | Color | Residue

Selecting Atoms and Residues

The selection facilities of the Sequence Editor can be used to locate the atoms belonging to a given residue or the residues containing selected atoms. They can also be used to select residues of a specific structure or property, and residues conserved across an alignment.

- Select a group of residues by dragging the left mouse button over residues in the Sequence Editor. This draws a selection box around the residues. All residues within this box will be selected. Now select a residue in the Sequence Editor by clicking on it with the left mouse button. This deselects all other residues. Choose SE | Selection | Atoms | Of Selected Residues. In the MOE Window, the atoms of that residue will be added to the current atom selection set.
- Clear the residue selection in the Sequence Editor by clicking the left mouse button within the residue area away from any residue. Select an atom in the MOE Window. Now use the SE | Selection | Residues | With Selected Atoms command to find the residue containing that atom.
- Select a residue by clicking in the horizontal ruler above the residues. The ruler indicates residue positions for alignment purposes. If several sequences are loaded in the Sequence Editor, clicking in the ruler will select all the residues (across chains) at that position or, in other words, within the column of residues.
- Select the atoms of that residue by choosing Atoms | Select in the Selected Residues popup. To activate the popup, click the mouse popup button in the residue drawing area of the Sequence Editor away from any residue.
- There are also Chain, Selected Chain, Residue, and Residue Column popup menus.

Assessment

Write a short summary of the various steps that you have performed in this tutorial. Include answers to the questions on page 5 and 16.